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IMPORTANT NOTICE

All statements, technical information, and recommendations in this document which relate to the products supplied
by Meggitt SA are based on information believed to be reliable, but unless otherwise expressly agreed in writing
with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before using this product, you must
evaluate it and determine if it is suitable for your intended application. You should also check our website at
www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, user manuals,
service bulletins and/or other instructions affecting the product.

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use
of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained
in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries,
translations or any other documents not authored and produced by Meggitt SA.

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products
purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA.

Meggitt SA reserves the right to alter any part of this publication without prior notice.

EXPORT CONTROL
The information contained in this document may be subject to export control regulations of the European

Community, USA or other countries. Each recipient of this document is responsible for ensuring that the transfer or
use of any information contained in this document complies with all relevant export control regulations. ECN N /A.

COPYRIGHT
Copyright © 2019 Meggitt SA
All rights reserved
Published and printed by Meggitt SA in Fribourg, Switzerland

The names of actual companies and products mentioned
herein may be the trademarks of their respective owners.

The information contained in this document is subject to change without notice.
This information shall not be used, duplicated or disclosed, in whole or in part,
without the express written permission of Meggitt SA.
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PREFACE

About these release notes

These release notes provide important information about the VM600 MPSx software from Meggitt’s Vibro-Meter®
product line. They are applicable to all installations using the version of VM600 MPSx software described by this
document, namely:

e VM600 MPS1 software version 2.8 build 000 (CD part number 209-500-100-028)
e VM600 MPS2 software version 2.8 build 000 (CD part humber 209-500-200-028).
Note: VM600 MPS2 software version 2.7 build 036 was the previously released version.

The release notes contain information about changes from previous versions, such as new features and
improvements, solved problems, bug fixes, and compatibility (hardware and software).

Users who are familiar with previous versions of the VM600 MPSx software may also find it useful to refer to the
respective release notes included in this document.

Important information to read before installing

The version of VM600 MPSx software included on the CD may not be the latest version and may be different from
any version already installed.

In order to ensure the reliable operation of a VM600 system, the version of the VM600 MPSx software used (that
is, MPS1 or MPS2) must be compatible with the versions of firmware running on the VM600 cards. For further
information, see 5 Compatibility.

Particular versions of VM600 MPSx software can be obtained from the following Meggitt FTP site (web browser
recommended):

* Host: https://ftp.mss.mymeggitt.com

* Login ID: mps

» Password: F0j3S6YB

NOTE: On this FTP site, the “Latest” folder always contains the latest official release of the
VM600 MPSx software.

Please contact Meggitt customer support if you require further assistance.
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1 Introduction

This document relates to version 2.8 build 000 of the MPS1 and MPS2 configuration software packages for use
with VM600 series machinery protection systems from Meggitt’s Vibro-Meter® product line.

It contains important information about changes from previous versions, hard- and software compatibility, solved
problems, improvements, new features and bug fixes, compared to the previous release.

For more general information on the VM600 MPSx software, or the entire machinery protection system, please
refer to the following Meggitt documentation (included on the CD-ROM, as well as into the installed system by the
installation routine):

- . .
. <=1 VM600 MPS1 software for machinery protection systems software manual,
(document reference MAMPS1-SW/E)

- . .
. <=1 VM600 MPS2 software for machinery protection systems software manual,
(document reference MAMPS2-SW/E)

- . . .
. <=1 VM600 machinery protection system (MPS) hardware manual, standard version,
(document reference MAMPS-HW/E)

- . . .
. <=1 VM600 machinery protection system (MPS) hardware manual, CSA version,
(document reference MAMPS-HW/E-CSA)

= .
. <=1 VM600 networking manual,
(document reference MAVM600-NET/E)

. -f_“l VM600 functional safety manual,
(document reference MAVM600-FS/E)

== . .
. <~ Firmware (embedded software) upgrades for cards in a VM600 rack manual,
(document reference MAVM600-FW/E).

Users who are familiar with previous versions may also refer to the respective release notes included in their
installation Media Kits:

e Software Release 2.7 build 036 is described in: VM600 MPSx software version 2.7 build 036 release notes

(“ReleaseNotes.pdf’)

e Software Release 2.7 build 030 is described in: VM600 MPSx software version 2.7 build 030 release notes
(“ReleaseNotes.pdf’)

e Software Release 2.7 build 020 is described in: VM600 MPSx software version 2.7 build 020 release notes
(“ReleaseNotes.pdf’)

e Software Release 2.7 build 012 is described in: VM600 MPSx software version 2.7 build 012 release notes
(“ReleaseNotes.pdf’)

e Software Release 2.7 build 011 is described in: VM600 MPSx software version 2.7 build 011 release notes
(“ReleaseNotes.pdf’)

e Software Release 2.7 build 010 is described in: VM600 MPSx software version 2.7 build 010 release notes
(“ReleaseNotes.pdf’)

e Software Release 2.7 build 000 is described in: VM600 MPSx software version 2.7 build 000 release notes
(“ReleaseNotes.pdf’)
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Software Release 2.6 build 001 is described in:

(“ReleaseNotes.pdf’)

Software Release 2.6 build 000 is described in:

(“ReleaseNotes.pdf’)

Software Release 2.5 build 000 is described in:

(“ReleaseNotes.pdf’)

Software Release 2.4 build 000 is described in:
Software Release 2.3 build 000 is described in:
Software Release 2.2 build 005 is described in:
Software Release 2.2 build 000 is described in:
Software Release 2.1 build 001 is described in:
Software Release 2.0 build 007 is described in:
Software Release 2.0 build 005 is described in:
Software Release 2.0 build 004 is described in:
Software Release 2.0 build 003 is described in:
Software Release 2.0 build 002 is described in:
Software Release 2.0 build 001 is described in:
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VM600 MPSx software version 2.6 build 001 release notes

VM600 MPSx software version 2.6 build 000 release notes

VM600 MPSx software version 2.5 build 000 release notes

VM600 MPS V2_4_000 Release Notes_revl.pdf
VM600 MPS V2_3_000 Release Notes_revl.pdf
VM600 MPS V2_2 005 Release Notes_revl.pdf
VM600 MPS V2_2_000 Release Notes_revl.pdf
VM600 MPS V2_1_001 Release Notes_revl.pdf
VM600 MPS V2_0_007 Release Notes_revl.pdf
VM600 MPS V2_0_006 Release Notes_revl.pdf
VM600 MPS V2_0_004 Release Notes_revl.pdf
VM600 MPS V2_0_003 Release Notes_revl.pdf
VM600 MPS V2_0_002 Release Notes_revl.pdf
VM600 MPS V2_0_001 Release Notes_revl.pdf
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2 New features

2.1 VMé600 MPSx software release 2.0 build 009

2.1.1 Add Refresh Database File menu item.

Added “Refresh Database Files” menu item at the Database level which forces all files in a database to have their
header information updated to the latest release level. If some files cannot be updated an HTML window is
displayed indicating which files weren’t updated. This most likely occurs because the file has the read-only
attribute set. It can also occur if another external program has the file opened.

2.1.2 Add capacity to set max number of data points.

Added a “Maximum Number of Data Points” field in the General Info page of the Machine Window. This field
allows the user to specify on a per machine basis the maximum number of data points to store per output when the
system is recording data. This change forced changes to Machine Information (*.ma”), Machine Data (*.dat), and
Machine Average Data (*.avg) files. These files are automatically updated when the user begins an MPS session.

2.1.3 Improvements to RLC and IOC Jumper Matrix displays.

The RLC and I0C Jumper Matrix pages at the rack level now display Jumper Information as an HTML display for a
nicer looking display and for cleaner print-out.

2.1.4 Historic Chart now indicates if new data is available

If the user was recording data and then displayed Historic Chart information there was no indication in the Historic
Chart display if new data was available to be displayed. A new toolbar button (Refresh) was created and is
enabled when new data arrives.

2.1.5 Tool bar button sizes and images have been changed.

The tool bar button sizes and bitmaps have been changed to be more consistent with those in CMS software, in
particular the “VMConfig” module.

2.1.6 Consistency Check logic is being added.
Various consistency checks and appropriate logic has been added, similar to the CMS consistency checks:

All MPS files must have read and write access. Flag as an error any files that don’t have the proper access rights.
Give write access to all files on auto-fix.

A minimal database requires that the "dbinfo.db" file exists. Flag this as an error if one doesn't exist. Create this
file on auto-fix.
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In the past there was a problem where machine files may not have the proper file type specified. This checks for
this problem and corrects it in auto-fix mode.

Racks may have board configurations with blank tags. This check updates these tags to the default tags.

2.2 VMé600 MPSx software release 2.0 build 010

2.2.1 The CPU Present radio button requires changes

The CPU Present button presented in the Rack Window has been changed to a CheckBox button to more
accurately reflect its usage.

2.2.2 Storage of the window size and position when the window is closed

This information is used when MPS software is subsequently initiated the next time. In order to be more user
friendly, the latest configured windows size and position are retained into the OS registry.

2.2.3 The Registry in now used to store information previously stored in the “mps.inf” file
This includes the following information:

¢ Software\Vibro-Meter\VM600 MPS Software\MPSx\Settings\Language

¢ Software\Vibro-Meter\VM600 MPS Software\MPSx\Settings\Master

o Software\Vibro-Meter\VM600 MPS Software\MPSx\Settings\MultiRateEnable

o Software\Vibro-Meter\VM600 MPS Software\MPSx\Settings\PollRate

¢ Software\Vibro-Meter\VM600 MPS Software\MPSx\Settings\SerialFlag

¢ Software\Vibro-Meter\VM600 MPS Software\MPSx\Settings\SimulateFlag

¢ Software\Vibro-Meter\VM600 MPS Software\MPSx\Settings\Super

o Software\Vibro-Meter\VM600 MPS Software\MPSx\Settings\User

¢ Software\Vibro-Meter\VM600 MPS Software\MPSx\Settings\ViewType.

2.2.4 AMC 8 presentation of the Bar Chart
The presentation of individual bar charts can be altered to improve their readability.

Min/Max levels are now more intelligently clipped.
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2.2.5 Inactivity Dialog Box changes

Inactivity Dialog box has been removed and the status line now used to inform the user of the privilege change

2.3 VM600 MPSx software release 2.1 build 001

2.3.1 Print All Pages Option added for IOC and RLC Jumper Windows.

Added the “Print All Pages” option for IOC and RLC windows so that all boards on a rack can have their jumper
window printed in a single operation.

2.3.2 Output Mapping -> DC Output IOC-4C still active.

The concept of an IOC-4C was never realized however the MPS software had accommodations for this board type.
In particular, the DC outputs showed outputs 5 to 8. All references to DC outputs 5 thorugh 8 and to I0OC-4C have
been removed.

2.3.3 Basic Function changes for MPC boards

The following is the new Basic Function for the MPC4 Alarm Logical Configuration. The main window displays the
Logical Function selection and a lower notebook allows the various alarms to be chosen. The main window
Summary box displays the current logical function in a shorthand text.

2.3.4 Preventinadvertent shutdown or stop of data recording.

Customer feedback requested that when the user is performing operations that will shutdown data recording that a
warning should be displayed indicating that recording will be discontinued. The user is now warned when he/she
attempts to stop data recording and must confirm that this is desired.

2.3.5 Discrete Output Selection Tags Updates

The Output selection tags are now updated to reflect any implied output names based on processing with respect
to the Discrete Output Window.

2.3.6 Implementation of a new card “MPC1"

An OEM request to implement a new card type dedicated for the combustion chamber and having specific filtering
characteristic, has been realized.
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2.3.7 Introduction of licensing of MPC1 capability

Logic was added to recognize the licensing key that the MPS KeyGen program produces to allow MPCL1 licensing.
If this licensing key is present then the MPS1 & 2 will execute as it did in previous MPS builds. The following
minimal logic changes based on when the licensing key is not present or MPC1 is not licensed were implemented:

If the user attempts to add a new card only the MPC4 and AMCS8 choices will be presented.
Dragging an MPC1 board to the rack level will cause an invalid drag/drop display message.

These two minor changes will prevent an unlicensed user from ever adding an MPC1 board to a database. If the
user is unlicensed for MPC1 capabilities but the current database was created on a system that was licensed then
the user will be able to edit the existing MPC1 boards but not copy them to a different slot.

2.3.8 KeyGen update to incorporate MPC1 option as code

Additional KeyGen options impact MPS code.

2.4 VM600 MPSx software release 2.2 build 000

2.4.1 Introduction of 1U Rack

A new rack, 1U, has been defined and implemented. The 1U rack is a 2-slot cage. The first slot is optionally
populated with an RLC on the back-side bus with no front-side board allowed. The second slot can be populated
with either an MPC4 or AMCS8 with the associated IOC on the backside. If an RLC is present then this RLC will be
treated as being on OCBus. The boards found in the second slot may have a slot assignment of 3 through 14. All
communications to boards found on a 1U rack is performed through serial I/O.

A new implementation of serial I/O COM port assignment was implemented so that multiple serial I/O assignments,
one per boards, can be made. Prior to this change, only a single serial /0O connection could be made.

All MPS communications can now be made via a CPUM or the serial connection of the board. Prior to this change,
data recording and bar/strip charts could only be performed if a CPUM was present.

2.4.2 Languages - Cleanup of German and French strings

A major improvement has been made on the quality of translation in all 3 available languages.

Document reference VM600OMPSSW-RN/E
Version 1 -27.09.2019 VM600 MPSx 2.8.000
15/78



Enabling the Extraordinary 4
To Fly To Power To Live l

2.5 VMé600 MPSx software release 2.3 build 000

2.5.1 Setup change to split Documentation library from MPS software

In order to facilitate transfer of the MPS software through slow connections it was decided to split the
documentation (TechPubs Library) from the setup.exe (now down to 10 MB). The new setup_techpub.exe is
automatically launched in the MPS setup when the related checkbox is ticked (default setting). An error message
occurs when this setup_techpub.exe has not been copied or cannot be found in any of the following directories:

- the directory in which the main "setup.exe" is located (root of CD-ROM)

- the subdirectory "Documentation” of the directory in which the main "setup.exe" is located
(CD-ROM:\Documentation)

- the current temp folder, into which the setup has extracted the installation files.

This also fixes the problem of empty pointers where the MPS SW installation used to put nonoperational shortcuts
to open the documentation.

2.5.2 Languages - Cleanup of German and French strings

Continuous effort has been put into cleaning up the translation, especially terms concerning the 1U rack.

2.5.3 MPS - extend + update catalogue of VM sensors
When adding Measurement channels the user now sees new sensor types.

In order to comply with the recent implemented conditioners philosophy, which allows to freely the chose the
desired sensitivity, care should be take when a sensor family “CA xxx” and a Conditioner “IPC*” are selected from
the lists. In this particular case the parameters “Signal Sensitivity” and “Signal Dynamic (x)” are voluntary set to
zero and shall be manually entered.

2.5.4 Extension of the MPCI1 filters settings to other GTs

The software allows multiple GT types for MPC1 boards. On the previous version only the GT13E2 filters settings
was supported, from version 2.3.00 both GT8 and GT11 filters settings has been added.

2.5.5 Use same RS232 serial port for several boards

The same COM port number could be allocated to several cards, to facilitate production process.

2.5.6 Add the Serial I/0O tool bar button to the AMC card window

To be consistent with the MPC-4 cards a tool bar button was added for the AMC card.
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2.6 VM600 MPSx software release 2.4 build 000

2.6.1 Channel Inhibit implementation

Each measurement and speed channel can be inhibited in order to allow the replacement of a defective sensor
(Communications - To MPC - Channel Inhibits). Any status linked to the inhibited sensor is set to the normal
state to not affect the behavior of the system.

The Channel Inhibit status can be included to a Basic Function to reflect the status of system.

The Channel Inhibit status (Channel Inhibited / Activated) is display in the list of events and the values of the output
windows are grayed out if the channel is inhibited.

The Channel Inhibit function needs the latest firmware version of the CPU-M, MPC-4 and AMC-8. Older version of
the boards can be used in the same rack, but the function is not accessible for the old boards and the status on
MPS software show all channels of old board as Activated.

2.6.2 Update the catalogue of Meggitt sensors

The catalogue of Meggitt (MSS) sensors has been extended. The additional Wilcoxon’s sensors 786A, 797L to
793L and 799LF are available from the measurement channels dropdown menu under the category “AC”.

2.7 VM600 MPSx software release 2.5 build 000

2.7.1 Dual Mathematical Function (DMF) processing

Dual Mathematical Function (DMF) processing has been added as a processing function for the dual-processing
channels of an MPC4 card, that is, for operation with Channel 1 & 2 and Channel 3 & 4.

The Dual Mathematical Function (DMF) processing supports the following mathematical operations:

RMS Sum Performs the RMS addition of two single-processing input channels: (Channel 1 + Channel 2) or
(Channel 3 + Channel 4).
Note: This operation requires that both input channels are configured with an RMS rectifier.

RMS Subtraction Performs the RMS subtraction of two single-processing input channels:
(Channel 1 - Channel 2) or (Channel 3 — Channel 4).
Note: This operation requires that both input channels are configured with an RMS rectifier.

SUM Performs the addition of two single-processing input channels:
(Channel 1 + Channel 2) or (Channel 3 + Channel 4)
Note: This operation requires that both input channels are configured with an RMS rectifier.

SUBTRACTION Performs the subtraction of two single-processing input channels: (Channel 1 — Channel 2) or
(Channel 3 - Channel 4).
Note: This operation requires that both input channels are configured with the same rectifier.

Document reference VM600OMPSSW-RN/E
Version 1 -27.09.2019 VM600 MPSx 2.8.000
17 /78



Enabling the Extraordinary r
To Fly To Power To Live l

X & Y MIN Returns the smaller value from two single-processing input channels: (Channel 1 & Channel 2) or
(Channel 3 & Channel 4).
Note: This operation requires that both input channels are configured with the same rectifier.

X & Y MAX Returns the larger value from two single-processing input channels: (Channel 1 & Channel 2) or
(Channel 3 & Channel 4).
Note: This operation requires that both input channels are configured with the same rectifier.

In order to use Dual Mathematical Function (DMF) processing with two single-processing input channels, both
single-processing input channels (Channel 1 & 2 or Channel 3 & 4) must be configured with the same single-
channel processing function (for example, Broad Band Absolute Bearing Vibration (BBAB)) and with rectifiers from
the same rectifier group (for example, AVG, RMS or True).

Note: The Dual Mathematical Function (DMF) processing function must be set to “No Processing” in order to
change the processing function for the associated single-processing channels.

2.7.2 SENSOR OK and SENSOR FAIL events
A new class of events, SENSOR events, has been added to the VM600 MPS software:

A SENSOR OK event is generated when the DC voltage of a sensor goes inside the OK levels configured for the
sensor.

A SENSOR FAIL event is generated when the DC voltage of a sensor goes outside the OK levels configured for
the sensor.

Note: The OK levels are defined using the Upper OK Level and the Lower OK Level for an input channel in the
Architectural View.

Sensor events (like ALARM and DIAG events) are displayed on the Event Info tab of the Logical View for the
database that the sensor is attached to.

Note: Events (Architectural View) are only available with the MPS2 software (not with MPS1).

2.7.3 Confirmation required before a configuration is sent o a card or rack

In order to avoid sending a configuration to a card or rack by accident, a message has been added that will prompt
the user for confirmation before a configuration is sent to a card or rack, overwriting the existing configuration.

After clicking a Send Configuration command, a “Do you really want to send the configuration?” message is
displayed and the user must click Yes before the configuration is sent to the card or rack.

2.7.4 Copy operations for MPC4 card configurations

When configuring MPC4 cards, copy operations are now supported that allow the Inputs or Processings and
Alarms already configured for an MPC4 card to be re-used elsewhere on the same MPC4 card. Using the copy
operations for MPC4 card configurations helps to make the management of VM600 MPS software configurations
easier. For example, the Inputs, Processing (and Alarms) could be configured for one channel of an MPC4 card
and then re-used for the other channels of the card.
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The Copy Inputs command is available for operation with the Inputs of an MPC card (Measurement channels 1 to
4 and Speed Channels 1 to 2).

The Copy Processings and Alarms command is available for operation with the Processing of an MPC card
(Processing channels 1 to 4, Dual Processing channel 1 & 2 and Dual Processing channel 3 & 4) including any
alarms configured for the processing channel.

To use the copy operation commands, either:

Click on an MPC4 card level node in the configuration tree to select it, then use the File > Copy Inputs and
File > Copy Processings and Alarms menu commands.

Right-click on an MPC4 card level node in the configuration tree, then click File > Copy Inputs or the
File > Copy Processings and Alarms.

Note: The copy operations for MPC4 card configurations are limited to the same MPC4 card (not between different
MPCA4 cards) and work on a channel basis, that is, the configuration of a single input channel can be copied to
another (single) input channel.

2.7.5 Configuration tree expansion restrictions

The behaviour of the configuration trees when switching between the Logical View (Databases, Stations, Machines
and Sensors) and the Architectural View (Databases, Racks and Card) in the MPS2 software has been changed.

Now, when switching between the Logical View and the Architectural View, the configuration trees displayed in
these views expand and display only the nodes immediately under the database level:

After switching to the Logical View, only Databases and Stations are displayed.
Station level nodes must be manually expanded to see more detailed information in this configuration tree.

After switching to the Architectural View, only Databases and Racks are displayed.
Rack level nodes must be manually expanded to see more detailed information in this configuration tree.

(Previously, when switching between the Logical View and the Architectural View, the configuration trees expanded
completely and displayed all available nodes. However, this behaviour made it difficult to find individual nodes in a
configuration tree , particularly for larger configurations.)

2.7.6 Sensor Information Editor

The Sensor Information Editor is a new program that allows the user to customize and manage the information in
the sensor list file that is copied to the computer as part of the VM600 MPS software installation process.

The sensor list file includes detailed information on the measurement chains (sensors/signal conditioners) for the
different sensor systems that are available from Meggitt, that is, information such as Sensor Family, Sensor Type,
Conditioner, Transmission Mode and Signal Sensitivity. When the VM600 MPS software (MPS1 or MPS2) is being
used to configure the input channels for an MPC4 machinery protection card, it uses the information in the sensor
list file to populate the drop-down list boxes and text boxes of the VM600 MPS software user interface when input
channels (Measurement Channels and Speed Channels) are being configured.

More specifically, the Sensor Information Editor allows sensors/signal conditioners be edited, added or removed.
Using the Sensor Information Editor helps to make the management of VM600 MPS software configurations easier.
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The Sensor Information Editor is started from the VM600 MPS software: click Database > Sensor Information
Editor to start the Sensor Information Editor.

When the Sensor Information Editor is running, click Help or press the F1 key to display the associated help text.

Note: To start the Sensor Information Editor, a Database must be selected in the configuration tree of the VM600
MPS software user interface and the User Level must be Super (Privileges > Super).

2.8 VM600 MPSx software release 2.6 build 000

2.8.1 Improved support for the safety (SIL) version of the MPC4 card

The MPC4 machinery protection card is available in different versions, including a standard version, a separate
circuits version and a safety (SIL) version. Refer to the VM600 machinery protection system (MPS) hardware
manual for additional information.

NOTE: The safety version of the MPC4 card (MPC4 SIL) does not have a VME bus
interface so it cannot communicate with a CPUM or any other cards in a VM600
rack. Accordingly, the MPC4 SIL card can only be configured via the RS-232
connector on its front panel.

Although earlier versions of the VM600 MPSx software supported the safety (SIL) version of the MPC4 card,
several new features have been added to VM600 MPSx version 2.6 in order to make it easier to work with
MPCA4 SIL cards:

Previously, the MPSx software referred to all versions of the MPC4 card as MPC4. Now, the MPSx software makes
a distinction between safety MPC4 cards and other MPC4 cards by referring to the standard version and the
separate circuits version of the MPC4 card as an MPC4 and referring to the safety version of the MPC4 card as an
MPC4 SIL.

Consequently, when adding an MPC4 card to a VM600 rack configuration, the user can select either:
e MPC4 —to add a standard or a separate circuits MPC4 card.
e MPC4 SIL - to add a safety MPC4 card.

This distinction continues in the configuration tree structure, where MPC4 cards are listed as either MPC4 or
MPC4 SIL. Also, when an MPC4 card is selected in the configuration tree structure, the image of the card
displayed in the main window of the VM600 MPSx software is different for MPC4 and MPC4 SIL cards.

It is important to note that the configuration for a standard or a separate circuits MPC4 card (MPC4) in the VM600
MPSx software cannot be sent to a safety MPC4 card (MPC4 SIL) in a VM600 rack, and the configuration for a
safety MPC4 card (MPC4 SIL) cannot be sent to a standard or a separate circuits MPC4 card (MPC4). Similarly,
the configuration for a standard or a separate circuits MPC4 card (MPC4) in a VM600 rack cannot be read to a

Document reference VM600MPSSW-RN/E
VM600 MPSx 2.8.000 Version 1 —27.09.2019
20/78



Enabling the Extraordinary r
To Fly To Power To Live l

safety MPC4 card (MPC4 SIL) in the VM600 MPSx software, and the configuration for a safety MPC4 card
(MPC4 SIL) cannot be read to a standard or a separate circuits MPC4 card (MPC4). However, it is possible to
convert an MPC4 card configuration in the VM600 MPSx software to an MPC4 SIL card configuration, or vice
versa, as explained below.

To facilitate working with MPC4 and MPC4 SIL cards, the VM600 MPSx software also now includes additional
commands:

e Check MPC4 SIL Configuration.
e MPC4 <—> MPC4 SIL Conversion.

The Check MPC4 SIL Configuration command is available from the shortcut menu that is displayed when an
MPC4 SIL card in the configuration tree structure is right-clicked. It is used to run an automatic consistency check
on the configuration for the safety MPC card (MPC4 SIL) and ensure that it meets the requirements for use in a
safety-related system. For example, alarms must be configured as latching, and output relays must be configured
as normally energised (NE), that is, de-energised to trip. Refer to the VM600 functional safety manual for additional
information.

NOTE: As all of the features supported by a safety MPC4 card (MPC4 SIL) are also
supported by a standard or separate circuits MPC4 card (MPC4), no configuration
information is lost when converting from an MPC4 SIL to a MPCA4.

However, not all of the features supported by a standard or separate circuits MPC4
card (MPC4) are supported by a safety MPC4 card (MPC4 SIL). For example, the
MPC4 SIL card does not support the Narrow Band (Tracking Vibration and Sy,ax
processing functions and it does not support danger bypass (DB) and trip multiply
(TM) functions.

While the consistency check (Check MPC4 SIL Configuration command) automatically checks the configuration
of an individual safety MPC4 card (MPC4 SIL) and ensures that it meets the requirements for use in a safety-
related system, a further manual check of the complete VM600 system configuration is required by the user in
order to identify and avoid possible conflicts from additional cards in the VM600 rack. For example, due to VM600
Raw Bus and/or OC Bus issues. Refer to the VM600 functional safety manual for additional information.

The MPC4 <—> MPC4 SIL Conversion command is available from the shortcut menu that is displayed when an
MPC4 or MPC4 SIL card in the configuration tree structure is right-clicked. It is used to automatically convert the
configuration for a standard or separate circuits MPC4 card (MPC4) to a configuration for a safety MPC4 card
(MPC4 SIL) or to convert the configuration for a safety MPC4 card (MPC4 SIL) to a configuration for a standard or
separate circuits MPC4 card (MPC4).
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NOTE: As all of the features supported by a safety MPC4 card (MPC4 SIL) are also
supported by a standard or separate circuits MPC4 card (MPC4), no configuration
information is lost when converting from an MPC4 SIL to a MPC4.

However, not all of the features supported by a standard or separate circuits MPC4
card (MPC4) are supported by a safety MPC4 card (MPC4 SIL), so some
configuration information can be lost when converting from an MPC4 to a

MPC4 SIL, depending on the configuration. For example, the MPC4 SIL card does
not support the Narrow Band (Tracking Vibration and S« processing functions,
and it does not support danger bypass (DB) and trip multiply (TM) functions.

Refer to the VM600 functional safety manual for additional information.

As a safety MPC4 card (MPC4 SIL) does not have a VME bus interface, it cannot communicate with a CPUM card
(or any other cards) in a VM600 rack. Accordingly, an MPC4 SIL card can only be configured via a direct
connection to the RS-232 connector in its front panel (even for a “networked” VM600 rack).

So when a user sends a configuration to a VM600 rack that contains safety MPC4 cards (MPC4 SILs), a message
box is displayed to remind the user that an RS-232 connection is required to configure MPC4 SIL cards. Similarly,
this is also done when a user reads a configuration from a VM600 rack that contains MPC4 SIL cards.

For additional information refer to the MPC4 SIL topic in the VM600 MPSx software version 2.6 help (click
Help > Contents or press the F1 key, and navigate to MPC4 SIL), the VM600 machinery protection system (MPS)
hardware manual and the VM600 functional safety manual.

Finally, it is worth noting that VM600 MPSx version 2.6 uses a text file in the background to help it make a
distinction between the different versions of MPC4 card. The text file (sil_info.txt) contains all of the hardware and
software ordering numbers (PNRs) for safety MPC4 cards (MPC4 SILs), which allows the VM600 MPSx software
to correctly identify MPC4 cards in a VM600 rack.

2.9 VMé600 MPSx software release 2.7 build 000

2.9.1 VMé00 MPS rack (CPUM) security

New VM600 MPS rack (CPUM) security features have been implemented that allow a VM600 MPS containing a
CPUM card to limit the functionality of the MPS that are available via the CPUM to Ethernet-based connections,
such as the VM600 MPSx software, the CPUM Configurator software or Modbus TCP.

These new CPUM security features are in addition to the VM600 MPSx software’s existing system of privileges
(user access rights) that control and limit the functionality of the software available to different levels of user.

NOTE: VM600 MPSx software version 2.7 or later and a networked VM600 rack containing
a CPUM card running firmware version 077 or later are required in order to use
VM600 MPS rack (CPUM) security.
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By default, the CPUM security features are disabled in order to ensure compatibility with currently deployed
systems (CPUM cards running firmware version 076 or earlier).

NOTE: The passwords and settings for CPUM security are stored on the CPUM card.

The use of CPUM security features is recommended in order to help prevent accidental or unauthorised access to
a VM600 MPS configuration and other machinery protection system functionality, thereby reducing the possibility of
interference in the operation of the protection system and the machinery being monitored.

For example, in a typical machinery monitoring application in a modern power-generating station, the VM600 MPS
is installed close to the machinery being monitored, which is installed in the highest-security zone of the plant. Such
security zones are usually restricted and protected areas with physical barriers, specific access requirements and
surveillance equipment. Accordingly, only approved and cleared personnel have the physical access to a VM600
MPS in a power station that is required in order to change the CPUM access setting (CPUM access lock), one of
the new CPUM security features.

The CPUM access lock prevents remote access to a VM600 MPS, effectively acting as a hardware lock, and it is
not possible to “unlock” a CPUM/VM600 remotely.

NOTE: As the CPUM access setting for a CPUM card is configured using the keys on the
front panel of the card, physical access to the CPUM card (VM600 rack) is
required.

The CPUM security features consist of two levels of protection integrated in the CPUM card: CPUM access lock
and MPS password validation

CPUM Access Lock is a CPUM access setting that can be thought of as a “hardware” security feature that limits
Ethernet-based connections to a VM600 MPS to “read only” operations.

¢ When CPUM access is blocked, the MPS operations that are available are limited to read only operations.
That is, communications with the VM600 rack via Ethernet is read only, such that it is possible to read
outputs from the MPS but it is not possible to change (commit) the configuration of a VM600 rack or to
interfere in the operation of the MPS.

e When CPUM access is allowed, the MPS operations that are available depend on the MPS password
validation (see below).

Physical access to the VM600 rack is required in order to change the CPUM Access Lock.
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MPS Password Validation can be thought of as a “software” security feature that limits Ethernet-based
connections to a VM600 MPS to “read only” operations plus a permitted subset of “write” operations.

¢ When MPS password validation is enabled, the MPS operations that are available are limited to read only
operations and certain specific write operations (“read + restricted write”), that is, write operations which
require additional authentication before being run. For example, VM600 MPS commands such as alarm
reset (AR) or changing a fieldbus configuration. While the read only operations run as usual, the write
operations require that the correct CPUM password is entered by the user before they are run.

e When MPS password validation is disabled, all VM600 MPS operations are available.

The VM600 MPSx software and CPUM access (CPUM Access Lock: Unlocked) are required in order to change
the MPS Password Validation.

Basically, the use of CPUM access lock protects the VM600 MPS configuration and prevents all sensitive VM600
MPS operations from being run (that is, “read only” — the highest level of security). Like CPUM access lock, the use
of MPS password validation protects the configuration of the MPC4 cards and AMCS8 cards in the VM600 rack but
MPS password validation also allows certain VM600 MPS operations to be run (that is, “read + restricted write” — a
reduced level of security). See the table on the following page for further information on the operations permitted
when CPUM security features are used.

NOTE: The CPUM access lock is a stronger protection mechanism than MPS password
validation and is used to implement the highest level of VM600 MPS rack security
(that is, with the fewest VM600 MPS operations available to the user).
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The VM600 MPS operations affected by the CPUM security features are shown in the table below.

CPUM security feature
VM600 MPS operation
. CPUM Access MPS Password
(protected by CPUM security features) Lock validation
Committing a VM600 MPS configuration . Password
Not available
protected
Running MPS commands via VM600 MPSx software:
» Alarms reset (AR)
» Channel inhibit (sensor bypass) . Password
» Danger bypass (DB) Not available protected
* Trip multiply (TM)
* Clear status latch
Running MPS commands via Modbus:
* Alarms reset (AR)
* Channel inhibit (sensor bypass) Not available Available
» Danger bypass (DB)
* Trip multiply (TM)
* Clear status latch
Changing a VM600 MPS fieldbus configuration (such as Modbus) Not available Available
Accessing a CPUM using an Ethernet-based connection such as Not available Available
CPUM Configurator, FTP or Telnet
D!splaymg VM600 MI?S njeasure_ment outputs such as the outputs Available Available
windows and plots (historical or live data)
Operation of a VM600 CMS condition monitoring system using . .
cards such as the CMC16/IOC16T in the same VM600 rack Available Available
Operation of a VibroSight condition monitoring system using cards . .
such as the XMx16/XIO16T in the same VM600 rack Available Available
MPS Password Validation security feature Not available Available
CPUM Access Lock security feature Available Available
Level of security Highest Reduced

Notes

When CPUM access is blocked (CPUM Access Lock: Locked), a VM600 MPS is limited to “read only” operations as shown
in the CPUM Access Lock column above.

When CPUM access is allowed (CPUM Access Lock: Unlocked), MPS Password Validation can be enabled

(MPS Password Validation: Enabled) and a VM600 MPS is limited to “read + restricted write” operations as shown in the
MPS Password Validation column above. However, while the read only operations run as usual, the write operations require
that the correct CPUM password is entered by the user before they are run.

When CPUM access is allowed (CPUM Access Lock: Unlocked) and MPS Password Validation is disabled

(MPS Password Validation: Disabled), a VM600 MPS can perform all operations (“read + write”). With these settings, no
VM600 MPS rack (CPUM) security is used, which is equivalent to using a VM600 system with VM600 MPSx software version
2.6 or earlier and CPUM firmware version 076 or earlier.
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The relationship between CPUM access lock, MPS password validation and access rights is shown in the table
below.

CPUM Access | MPS Password .
Lock Validation Access rights Notes
Locked Read only Highest level of security
Enabled with
Unlocked password not Read only
entered
correctly
Reduced level of security
Enabled with
password Read +
Unlocked entered restricted write
correctly
Lowest level of security.
This is equivalent to using a VM600
Unlocked Disabled Read + write system with VM600 MPSx software
version 2.6 or earlier and CPUM
firmware version 076 or earlier.

Displaying CPUM security settings

The VM600 MPSx software can be used to communicate with the CPUM card in order to read and display the
current state of the CPUM security settings.

NOTE: The VM600 MPSx software privilege level must be at Master or Super in order to
access the CPUM Security command.

To read the CPUM security settings:

1. Click on a rack level node in the configuration tree to select it, then use the Communications > CPUM
security menu command.
Alternatively, right-click on a rack level node in the configuration tree, then click CPUM security.

2.In the CPUM Security window that appears, under Rack Selection, in the Hostname field, enter either the
IP address of the rack (CPUM card) in dot-decimal notation or a predefined host name. Then click the
Read Security Settings button.
The CPUM Security window updates and displays, under CPUM Security Settings, the status of the
CPUM access (CPUM Access Lock) and the status of the MPS password validation (MPS Password
Validation).
The “session” information (Session Information) shows if the VM600 MPSx software is logged on to the
CPUM card, which happens either automatically upon entering the correct CPUM password when running
a VM600 MPS command or manually by using the Log On To CPUM card button.
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NOTE: The fields under CPUM Security Settings are unavailable (greyed out) until the
Read Security Settings button is used to establish communications with the
CPUM card.
If the CPUM security settings change, for example, using the keys on the front
panel of the card, then the Read Security Settings button must be used to read
the security settings from the card (as the CPUM Security window does not update
automatically).

Allowing or blocking access to the CPUM

CPUM access is allowed by default so that the CPUM card and VM600 rack can communicate with the VM600
MPSx software and compatibility with earlier versions of CPUM firmware is maintained.

To block access to a CPUM card (and limit the VM600 MPS to “read only” operations):

e When CPUM access is allowed, simultaneously pressing the OUT—-, SLOT- and SLOT+ keys on the front
panel of the CPUM card will block access to the card, that is, the CPUM Access Lock setting toggles from
Unlocked to Locked.

To indicate that the CPUM card is locked, the DIAG LED on the front panel of the CPUM card slowly blinks
green (approximately once per second).

To allow access to a CPUM card:

e When CPUM access is blocked, simultaneously pressing the OUT-, SLOT- and SLOT+ keys on the front
panel of the CPUM card will allow access to the card, that is, the CPUM Access Lock setting toggles from
Locked to Unlocked.

To indicate that the CPUM card is unlocked, the DIAG LED on the front panel of the CPUM card shows
green (continuously).

In addition, after changing the CPUM access setting, the CPUM Security window in the VM600 MPSx software
can be used to display (refresh) the CPUM security settings (by running the Read Security Settings command).

Enabling and disabling MPS password validation on a CPUM

MPS password validation on a CPUM card is disabled by default so that the CPUM card can communicate with the
VM600 MPSx software and compatibility with earlier versions of CPUM firmware is maintained.

NOTE: CPUM access must be allowed (CPUM Access Lock: Unlocked) in order to work
with MPS password validation.

To enable password validation on a CPUM card (and limit the VM600 MPS to “read + restricted write” operations):

1. Click on a rack level node in the configuration tree to select it, then use the Communications > CPUM
security menu command.

Alternatively, right-click on a rack level node in the configuration tree, then click CPUM security.
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2.In the CPUM Security window that appears, under CPUM Security Settings, for the
MPS Password Validation field, click the Enable option.

3.In the Set CPUM Password window that appears, enter the new password and enter the new password
again to confirm it, then click OK.

MPS password validation is enabled and the CPUM Security window updates.

To disable password validation on a CPUM card:

1.In the CPUM Security window, under CPUM Security Settings, for the MPS Password Validation field,
click the Disable option.

2.In the Enter CPUM Password window that appears, enter the password, then click OK.

MPS password validation is disabled and the CPUM Security window updates.

Changing the password on the CPUM
To change the password used by a CPUM card for authentication:

1.In the CPUM Security window, under CPUM Security Settings, for the CPUM Password Validation field,
click the Change CPUM Password button.

2.In the Change CPUM Password window that appears, enter the old password and the new password, and
enter the new password again to confirm it, then click OK.

The CPUM password is set, MPS password validation is enabled, and the CPUM Security window updates.

NOTE: CPUM access must be allowed (CPUM Access Lock: Unlocked) in order to work
with MPS password validation.

Logging on and off a CPUM

When MPS password validation on the CPUM card is used, whenever the VM600 MPSx software is asked to
perform a restricted operation such as alarm reset (AR), the software will prompt the user for the CPUM password
before continuing.

If the correct CPUM password is used, then the VM600 MPSx software will automatically log on to the CPUM card
and perform the requested operation. When the software logs on to the CPUM card in this way, it will remain
logged on to the CPUM card in a “session” until the CPUM Security window is used to log off from the CPUM card
or the software is closed (exited).

In a session, it is not necessary re-enter the CPUM password every time a restricted operation is requested.
However, such sessions also have a timeout of 10 minutes, so if no restricted command (that is, a command
normally requiring a password) is run during a 10 minute period, then the session automatically logs off.
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However, if an incorrect CPUM password is used, then VM600 MPSx software will not log on to the CPUM card
and the requested operation is not performed.

To manually log on to a CPUM card:

1.In the CPUM Security window, under CPUM Security Settings, for the Session Information field, click the
Log On To CPUM card button.

2.In the CPUM Login window that appears, enter the password, then click OK.

The VM600 MPSx software is logged on to the CPUM card and the CPUM Security window updates.

To log off from a CPUM card:

1.In the CPUM Security window, under CPUM Security Settings, for the Session Information field, click the
Log Off From CPUM card button.

The VM600 MPSx software is logged off from the CPUM card and the CPUM Security window updates.

If the CPUM security settings change, for example, using the keys on the front panel of the card, or the VM600
MPSx software is closed (exited), any open sessions with a CPUM card are automatically closed (logged off).

Resetting the CPUM security settings
If necessary, the CPUM security settings can be reset to their default values of:
e CPUM Access Lock: Unlocked
e MPS Password Validation: Disabled.
When the CPUM security settings are reset, any open sessions with the CPUM card are automatically closed:

e Session Information: Logged off.

NOTE: Physical access to CPUM card (VM600 rack) is required in order to reset the
CPUM security settings to their default values.

To reset the CPUM security settings:

e Simultaneously press and hold the OUT-, SLOT- and SLOT+ keys on the front panel of the CPUM card for
five seconds.

To indicate that the CPUM card is reset, the DIAG LED on the front panel of the CPUM card quickly blinks
green (approximately twice per second) for five seconds. Then, the DIAG LED resumes normal operation
(continuous green when the CPUM is running correctly and off when the CPUM is starting).

In addition, after resetting the CPUM security settings, the CPUM Security window in the VM600 MPSx software
can be used to display (refresh) the CPUM security settings (by running the Read Security Settings command).
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2.9.2 CPUM Configurator software

CPUM Configurator is now included with VM600 MPSx software version 2.7 or later and is copied to the computer
as part of the VM600 MPSx software installation process.

NOTE: CPUM Configurator is a program that communicates with a CPUM card in a VM600
rack over an Ethernet (TCP/IP) link. Basically, it provides a graphical user interface
for a Telnet session between a CPUM Configurator (Telnet client) and a CPUM
card (Telnet server), and is used primarily for configuring and managing CPUM
cards / VM600 racks

Refer to the VM600 networking manual for further information on the
CPUM Configurator software.

Previously, CPUM Configurator was only available from Meggitt customer support (see 7.1 Contacting us).

2.10 VM600 MPSx software release 2.7 build 010

There are no new features in VM600 MPS 2.7 build 010 as this version was released to solve specific existing
problems and bugs. See 3.11 VM600 MPSx software release 2.7 build 010.

2.11 VM600 MPSx software release 2.7 build 011

2.11.1 Sensor Information Editor file updates

The underlying sensor list files (“sens_vm.txt” and “sens_vm_factory.txt”) used by the Sensor Information Editor of
the VM600 MPS software were updated to use more up-to-date sensor information.

For example, the default OK Levels used to check for problems with the front-end of measurement chains were
updated for some sensors, some obsolete sensors and measurement chains were removed, and the GSI 127
galvanic separation unit is now included.

See also 3.12.2 Sensor Information Editor stops responding after adding a new sensor.
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2.12 VM600 MPSx software release 2.7 build 012

2.12.1 CPUM Configurator software

The CPUM Configurator software included with the VM600 MPSx software was updated to support a number of
improvements.

NOTE: CPUM Configurator is a software tool included with VM600 MPSx software version
2.7 or later and is copied to the computer as part of the VM600 MPSx software
installation process. It can also be obtained from Meggitt customer support.

CPUM Configurator is used primarily for configuring CPUM cards and managing
VM®600 racks over Ethernet links.

Refer to the VM600 networking manual for further information on the

CPUM Configurator software.

Configuration of a CPUM card’s default gateway

When used with a CPUM card running firmware version 076 or later, the latest version of the CPUM Configurator
software now allows the default gateway of the CPUM card to be easily configured.

Start CPUM Configurator, click Configure IP and use the CPUM TCP-IP Configuration window that appears to
enter the required IP address in the Default gateway control. (The Default gateway control is unavailable (greyed
out) for CPUM cards running firmware version 075 or earlier.)

When OK is clicked to confirm any changes, then CPUM Configurator adds the
gateway = xxx.xxx.xxx.xxx line, with the IP address of the gateway in dot-decimal notation, to the net.cfg
file, updating it on the CPUM card.

NOTE: In order for any changes to the net . cfg file to take effect, the CPUM card must be
restarted.

To remove the default gateway of the CPUM card, use the CPUM TCP-IP Configuration window to delete (clear)
the IP address from the Default gateway control. When OK is clicked to confirm any changes, then

CPUM Configurator removes any existing gateway = xxx.xxx.xxx.xxx line from the net.cfg file, updating it
on the CPUM card.

Previously, the default gateway for a CPUM card could only be configured by manually editing one of its
configuration files, for example, the net . cfg file for CPUM cards running firmware version 076 or later and the
sysinit file for CPUM cards running firmware version 075. Refer to the VM600 networking manual for further
information.
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CPUM Configurator Connection check status

The relationship between the IP Address and the Connection check status controls displayed by the
CPUM Configurator software was changed so that the Connection check status now only changes to Unknown
when the IP Address has actually changed.

Previously, the Connection check status changed to Unknown whenever the IP Address was edited, even if it had
not actually been changed.

CPUM Configurator feedback

When using the CPUM Configurator software, feedback such as status information and results of operations
performed by CPUM Configurator is given using individual dialog boxes and/or in the Action status output text
box.

The latest version of the CPUM Configurator software now provides additional information about a CPUM card,
including:

e The version of firmware running on the card.
e The version of the card:

» Later versions of the CPUM card (PNR 200-595-076-HHh or later) fitted
with the PFM-5411 or equivalent CPU module.

» Earlier versions of the CPUM card (PNR 200-595-075-HHh or earlier) fitted
with the MSM586EN or equivalent CPU module.

¢ The type of configuration running on the card, such as a standard configuration or
a “known” user configuration.

See also 3.13 VM600 MPSx software release 2.7 build 012.

2.13 VM600 MPSx software release 2.7 build 020

There are no new features in VM600 MPS 2.7 build 020 as this version was released to solve specific existing
problems and bugs. See 3.14 VM600 MPSx software release 2.7 build 020.
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2.14 VM600 MPSx software release 2.7 build 030

2.14.1 VMé00 MPSx installer
The VM600 MPSx installer software has been updated to support more installation options.
More specifically, the VM600 MPSx installer can now optionally install the following software:

e Sample Configuration
(Example VM600 MPSx software database.)

e CPUM Configurator
(Software for configuring CPUM cards and managing VM600 racks over Ethernet links.)

e |IRC4 Configurator
(Software for configuring IRC4 cards.)

NOTE: Previously, the IRC4 Configurator software was distributed separately.

To optionally install the Sample configuration, CPUM Configurator software or IRC4 Configurator software:
1. Run the VM600 MPSx installer software (setup.exe).
2. When prompted to select the Setup type, select the Custom option then click Next.

3. When prompted to Select features, select the check box for the required options (and clear the check box for
the options not required):

e |IRC4 Configurator
e Sample Configuration
e CPUM Configurator.

4. Then click Next and continue with the installation as usual.

2.14.2 Support for measurement chains with a negative sensitivity by VM600 AMC8 cards

For VM600 AMCS cards, the configuration of single-channel processing has been updated to support negative
sensitivities in order to support even more measurement chains.

NOTE: The VM600 AMCS8 card has always supported negative sensitivities but earlier
versions of the VM600 MPSx software could not be used to configure this feature.

More specifically, when configuring single-channels using linear compensation (Sensor compensation type:
Linear), a negative value can now be used for the compensation sensitivity value (Sensitivity (deg C/...), under
Linear compensation).
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2.14.3 Support for the new IPC707 signal conditioner

The IPC707 signal conditioner from Meggitt's Vibro-Meter® product line converts the charge-based signal from
piezoelectric sensors, such as CAxxx piezoelectric accelerometers and CPxxx piezoelectric pressure sensors, into
a current or a voltage signal suitable for input to a machinery monitoring system. It is a versatile and highly-
configurable device that supports optional diagnostic circuitry that automatically detects and remotely indicates
problems with the measurement chain.

NOTE: The IPC707 signal conditioner is suitable for safety-critical applications as it was
developed in accordance with the IEC 61508 “functional safety” and ISO 13849-1
“safety of machinery” standards. The IPC707 combines enhanced reliability and
significant risk reduction, to help ensure increased system availability.

The IPC707 signal conditioner will become available in the summer of 2018. It is compatible with different
piezoelectric materials and will replace the different versions of the IPC704 signal conditioner (PNR 244-704-000-
xxX). That is, as production of the IPC707 increases, production of the IPC704 will decrease until will the IPC707
ultimately replaces the IPC704.

How it works

As shown in the measurement chain and output signal drawings below, the output signal from an IPC707 consists
of a dynamic measurement signal (AC) sitting on a bias level (DC). For an IPC707 with diagnostics, the nominal
value of the bias level (DC) is updated to indicate the integrity of the measurement chain and the validity of its
measurements:

Typical CAxxx or CPxxx and IPC707 measurement chain

Monitoring
r : and protection

system
! (such as
J i L ‘ VMB00 or
— VibroSmart™)

=
T

CAXXxx or Cabling IPC707 Transmission cable GSl127 Cabling J
CPxxx

IPC707 output signal

Dynamic measurement
signal (AC) ...

... on a nominal bias
level (DC)

For an IPC707 with diagnostics, as shown in the output bias level table below, the bias level (DC) uses different
nominal values to indicate the status (health) of the measurement chain:
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IPC707 output —nominal value of the bias level (DC)

13 mApc or 8 Vpc 11 mApc or 6 Vpc 10 mApc or 5 Vpc <8 MApc or <3 Vpc

N I tion — th
orma; operation © Other problem with the

dynamic pressure Problem with the Problem with the signal .

; . . measurement chain or
signal (AC) can be sensor and/or cabling conditioner
trusted power supply

To configure a dynamic measurement channel of an MPC4 or MPCA4SIL card for operation with an IPC707 signal
conditioner:

1. Inthe configuration tree structure of the Architectural view (left), under the database, rack, card and inputs,
select the measurement channels node level.

2. Inthe main working window (right), select the measurement channel to configure by clicking the appropriate
tab at the top of the window (Channels 1 to 4).

3. Configure the type of front-end equipment (measurement chain) used by selecting the Sensor family,
Sensor type and Conditioner type as usual.

When Sensor type is configured as CAxxx or CPxxx, the Conditioner type can be configured as one of the
IPC ... options.

4. For a measurement chain using an IPC707 signal conditioner, ensure that the
Signal sensitivity by calculation (IPC707) check box is selected.
Note that the Sensor sensitivity, Transfer function and IPC707 with diagnostics controls are available for
use, while the Signal sensitivity control is not available (greyed out).

NOTE: For a measurement chain using an IPC704 signal conditioner, the
Signal sensitivity by calculation (IPC707) check box is not selected (the default).
Note that the Signal sensitivity control is available for use, while the
Sensor sensitivity, Transfer function and IPC707 with diagnostics controls are
not available (greyed out).

5. For the IPC707 signal conditioner, enter the values for the Sensor sensitivity and the Transfer function.

For example: ... pC/g and ... pA/pC or ... mV/pC for a CAxxx piezoelectric accelerometer; ... pC/mbar and
... HA/pC or ... mV/pC for a CPxxx piezoelectric pressure sensor.
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6. For an IPC707 signal conditioner with diagnostics, if the IPC707 with diagnostics check box is selected, the
OK levels (Upper OK level and Lower OK level) are automatically configured to use values corresponding to
the ‘normal operation’ of the IPC707 (that is, OK levels centred around the nominal value of 13 mApc or 8 Vpc).

NOTE: The OK levels are used to monitor the incoming signal for problems arising in the
front end of the measuring chain. These problems can be due to, for example, a
defective sensor or signal conditioner, a faulty transmission line (open or short
circuit).

The OK levels are set by default when one of the sensors and from Meggitt’s
Vibro-Meter® product line is selected.

7. The remainder of the card is configured as usual.

8. The configuration is sent (downloaded) to the card as usual.

Once configured in this way, if a measurement chain using an IPC707 signal conditioner with diagnostics develops
a problem, it will be automatically detected and reported by the VM600-based monitoring and protection system.

For reasons of backwards compatibility, when a card configuration using an IPC707 signal conditioner is read
(uploaded) from an MPC4 or MPCA4SIL card, the IPC707-related controls are not completed. (Basically, the
IPC707-related controls are additional information which is not stored on the cards.)

Example configuration with IPC707 signal conditioner sent to card:

| MKD20CY011 Sensor Tag

|Y=5 _vJ Sensor Connected ¥ Signal sensitivity by calculation (IPC707)

|g ﬂ Sensor Sensitivity Unit 10.35 Sensor sensitivity (pC/g)
| 414  Signal Sensitivity (uA/g) 4 Transfer function (uA/pC)

I 100 Signal Dynamic (g) ¥ IPC707 with diagnostics

Example configuration subsequently read back from card:

I MKD20CY011 Sensor Tag

[Ves Ll Sensor Connected [T Signal sensitivity by calculation (IPC707)

Ig L] Sensor Sensitivity Unit 0 Sensor sensitivity (pC/g)
I 414 Signal Sensitivity (uA/g) 0 Transfer function (uA/pC)

[ 100 Signal Dynamic (g) I

From the screen shots above, it can be seen that the VM600 MPSx software uses the IPC707-related controls
(Sensor sensitivity and Transfer function) to calculate an MPC4 or MPCA4SIL card value (Signal sensitivity)
that is used by the card.

Document reference VM600MPSSW-RN/E
VM600 MPSx 2.8.000 Version 1 —27.09.2019
36/78



Enabling the Extraordinary r
To Fly To Power To Live l

2.15 VM600 MPSx software release 2.7 build 034

2.15.1 Smax processing changes for VMé600 MPC4 cards

For VM600 MPC4 cards, the S« processing (SMAX) has been updated to support two rectifiers, that is,
Rectifier function: True peak or Scaled true peak-to-peak.

For earlier versions of VM600 MPSx software (release 2.7 build 020 or earlier), Sy,ax processing supported both a
True peak rectifier and a True peak-to-peak rectifier.

For the previous version of VM600 MPSx software (release 2.7 build 030), Sy« processing supported a True peak
rectifier only.

For the latest version of VM600 MPSx software (release 2.7 build 036), Syhax processing now supports both a

True peak rectifier and a Scaled true peak-to-peak rectifier.

(The latest Scaled true peak-to-peak rectifier actually performs exactly the same processing as the earlier

True peak-to-peak rectifier, but it is now more appropriately named to indicate that it is in fact a calculated (‘scaled’)
value as opposed to a directly measured value.)

2.15.2 VMé00 CPUx card terminology
The VM600 MPSx software can be used with different versions of VM600 CPUx cards, namely:

e CPUM modular CPU card and optional IOCN input/output card.
This is the original CPU card.

e CPUR/IOCR rack controller and communications interface card pair.
This is the first version of the CPUR / IOCR card pair, which supports redundant operation when two
functionally equivalent CPUR / IOCR card pairs are installed in the same VM600 rack.

e CPUR2/IOCR2 rack controller and communications interface card pair.
This is the second version of the CPUR / IOCR card pair, which supports PROFIBUS DP
fieldbus communications.

Accordingly, the VM600 MPSx software has been updated to use more correct and consistent VM600 CPUx card
terminology as follows:

e CPUx is now used to refer to CPUM, CPUR and CPUR2 cards.

e CPUM is used to refer to CPUM (and IOCN) cards only, if required.

e CPUR is used to refer to CPUR (and IOCR) cards only, if required.

e CPURZ2 is used to refer to CPUR2 (and IOCRZ2) cards only, if required.
e |OCx is used to refer to IOCN, IOCR and IOCR2 cards.

e Andsoon.
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For example, in the user interface of the VM600 MPSx software:
e CPUx card in rack refers to all VM600 CPUx cards and replaces CPU present.
e Rack security (CPUx card) refers to all VM600 CPUx cards and replaces CPUM security.

e CPUx card security settings refers to all VM600 CPUXx cards and replaces CPUM security settings.

Previously, the VM600 MPSx software used VM600 CPUM card terminology to refer to CPUM, CPUR and CPUR2
cards (simply because only the CPUM card was available when the VM600 MPSx software was originally
developed; the CPUR and CPUR2 cards are much more recent.)

2.15.3 Sensor catalogue updates

The underlying sensor catalogue (list) used by the VM600 MPSx software when configuring MPC4 card inputs
(measurement channels and speed channels) has been updated with changes for specific sensors as, shown in
the table below:

Old value
Sensor Parameter New value
(for reference only)

SE120 Signal transmission mode Voltage Current
CV210 Upper OK level -6000 (nA) —7000 (uA)
with IVC632 [I] Lower OK level ~18000 (pA) -17000 (uA)
CV210 Upper OK level -2100 (mV) -2500 (mV)
with IVC632 [V] Lower OK level ~12900 (mV) ~12500 (mV)

Upper OK level -6000 (MA) —=7000 (uA)
VE210 [I]

Lower OK level -18000 (unA) —17000 (uA)

Upper OK level -2100 (mV) -2500 (mV)
VE210 [V]

Lower OK level -12900 (mV) —12500 (mV)
TQ4xx (2 mm) . . . Current (by default but

I f
with 105450 [I] Signal transmission mode Current (fixed) Ty mm—
TQ4xx (2 mm) . L ) Voltage (by default but

S It d Volt fixed

with 105450 [V] ignal transmission mode oltage (fixed) Ty m—
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2.15.4 MPC4 card measurement channel user interface

When an MPC4 card measurement channel is configured for operation with any specific sensor from the underlying
sensor catalogue — apart from Generic — the Signal transmission mode is automatically configured as Current or
Voltage, as appropriate for the sensor, and cannot be changed (that is, the Signal transmission mode control
becomes unavailable (greyed out)).

When an MPC4 card measurement channel is configured for operation with a user defined sensor sensitivity unit
(Sensor sensitivity unit: User defined), the additionally required User defined unit label control is now
displayed on the bottom left of the measurement channel tab (user interface).

Previously, the User defined unit label control was displayed on the centre right of the measurement channel tab.
See also 3.16.1 Problems configuring IPC707 signal conditioners.

2.15.5 Displaying or hiding specific measurements when displaying VMé00 MPS2 software
charts from a Windows command prompt

When displaying VM600 MPS2 software charts from a Windows command prompt, it is now possible to display or
hide specific measurements (sensor tags) using command-line options, as follows:

e -0
The -o command-line option is used to display only the specified measurements in the chart.

e -h
The -h command-line option is used to hide the specified measurements from the chart, displaying all others.

Examples

To display a bar chart including all available measurements (attached sensor tags), enter the following command at
a Windows command prompt:

"C:\Program Files (x86)\VM600 MPS\Bin\BarChart.exe" "-all" "-len"
"-pC:\Program Files (x86)\VM600 MPS\Configuration" "-dSample Database"
"-sStation 1" "-mMachine 1"

Where

-all specifies that all available measurements (attached sensor tags) should be displayed. If ~a11 is not used,
then a measurement point selection window is displayed in order to manually select the measurements to be
included in the chart.

-1 specifies the language to use for the user interface of the chart, as follows: -1en for English,
-1fr for French,and -1de for German.

-p specifies the path to the database, that is, where the *.db folder is located.
-d specifies the name of the database, that is, the file name of the *.db folder.

-s specifies the name of the station in the database (from the logical view of the database).
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-m specifies the name of the machine in the station in the database (from the logical view of the database).
-o specifies the measurements to be included in the chart (all others are not displayed).

-h specifies the measurements not to be included in the chart (all others are displayed).

NOTE: In order to use the -o or -h command-line options, the —a11 command-line option
must also be used.
If -all is not used with -o or -h, a measurement point selection window is
displayed and the -o or —-h options are effectively bypassed/ignored.

To display a bar chart including only the specified measurements V1V, V2V and V3V, enter the following command
at a Windows command prompt:

"C:\Program Files (x86)\VM600 MPS\Bin\BarChart.exe" "-all" "-o V1V V2V V3V"
"-len" "-pC:\Program Files (x86)\VM600 MPS\Configuration"
"-dSample Database" "-sStation 1" "-mMachine 1"

To display a bar chart including all available measurements except for the specified measurements V1V, V2V and
V3V, enter the following command at a Windows command prompt:

"C:\Program Files (x86)\VM600 MPS\Bin\BarChart.exe" "-all" "-h VIV V2V V3V"
"-len" "-pC:\Program Files (x86)\VM600 MPS\Configuration"
"-dSample Database" "-sStation 1" "-mMachine 1"

The -0 and -h command-line options can be used with all VM600 MPS2 software charts. For example:
e Bar charts

"C:\Program Files (x86)\VM600 MPS\Bin\BarChart.exe" "-tbar" "-all" ..

NOTE: By default, running the BarChart .exe command at a Windows command prompt
will display a bar chart, which is equivalent to running the BarChart.exe
command with the -tbar command-line option.

To display a trend chart, run the BarChart.exe command with the -tstrip
command-line option.

e Strip charts

"C:\Program Files (x86)\VM600 MPS\Bin\BarChart.exe" "-tstrip" "-all" ..
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e Trend charts

"C:\Program Files (x86)\VM600 MPS\Bin\TrendChart.exe" "-ttrend" "-all" ..

e Trend charts (averages).

"C:\Program Files (x86)\VM600 MPS\Bin\TrendChart.exe" "-tavg" "-all" ..

2.16 VM600 MPSx software release 2.8 build 000

2.16.1 VMé400 system and measurement event logging

The VM600 CPUM card now implements an automatic logging service responsible for the recording and storing
VM600 system data in a series of event log files:

e System events log

This log is used to record VM600 system events at the rack level, such as the detection of card or configuration
events (for example, change of Master CPUR and/or configuration changes).

e Measurement events log

This log is used to record VM600 measurement events at the MPC4 and AMCS8 card level, such as the
detection of alarm events (for example, changes to Alert and/or Danger statuses).

The event log files are stored in non-volatile memory on the CPUM card, thereby providing valuable information to
the operating history of a system (VM600 rack and cards) via the VM600 MPSx software. The event log files are
user readable (text-based) data files that are downloaded from a CPUM card using the VM600 MPSx software
version 2.8 or later.

The CPUM card’s logging service is automatic (no configuration required) and is limited to a maximum of 10000 of
the most recent events. Each event is recorded with a timestamp using the VM600 rack system time

(see 2.16.5 Easier configuration of time and date for a VM600 CPUM card). There are automatic built-in
mechanisms to manage the size of the stored data.

System events
The types of system events recorded to the System events log are:

e Card detection

e Card configuration

e Card configuration received

e Card configuration rejected: not authorized
e Modbus configuration received

e Modbus configuration succeeded
e Modbus configuration failed

e XMC configuration received

e XMC configuration succeeded

e XMC configuration failed

e New time settings activated
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e Rackis online

e Rack is offline

e Board resets

e CPUM exception, VME failure

e CPUM exception, Sync problem

e Generic CPUM exception

e Alarm reset received

e Alarm reset rejected: not authorized

e Front panel alarm reset

e Status latch clear received

e Status latch clear rejected: not authorized
e Password change succeeded

e Password change failed previous password doesn't match
e Successfully login to session

e Session login reject : wrong password

e Successfully logout from session

e Configuration port closed

e Configuration port open

Measurement events
The types of measurement events recorded to the measurement events log include:

e Low Danger (Danger-)
e Low Alarm (Alarm-)

e Normal Event

e High Alarm (Alarm+)

e High Danger (Danger+)
e Alarm Reset On

e Alarm Reset Off

e Danger Bypass On

e Danger Bypass Off

e Basic Function On

e Basic Function Off

e Advanced Function On
e Advanced Function Off
e Low Alert

e High Alert

e Validity Fault

e Speed Reference Fault
e Value Error bit set

e Value Error bit cleared
e SOK Failed

e SOK Passed

e Trip Multiply On

e Trip Multiply Off

e Sensor Bypass On

e Sensor Bypass Off

e Channel Check (OK) Passed
e Channel Check (OK) Failed.
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Accessing the system events and measurement events log files

The data logs (system events and measurement events) are downloaded from a CPUM card using the VM600
MPSx software version 2.8 or later.

To download a system event or measurement event log file using the VM600 MPSx software:

1. Inthe configuration tree structure (left (architectural view)), select a rack containing a CPUM card.

2. Onthe Communications menu, click Download measures events log or Download system events log as
appropriate, and use the resultant Save As dialog box to indicate in which folder and under what name the
events log file should be saved. Then click Save.

2.16.2 VMé00 CPUM card front-panel display improvements

The front-panel display on the VM600 CPUM “rack controller” card now displays additional information for the
CPUM card and the VM600 rack, and for the installed MPC4 and AMC8 monitoring cards.

For the CPUM card and the VM600 rack
The front-panel display on the VM600 CPUM card now displays additional VM600 system information as follows:

e CPUM card:

o Main page that displays CPUM card run time, VM600 rack system time and VM600 rack (CPUM)
security status.
Note: The Main page is the default page for the CPUM card and the VM600 rack.

o |IP page that displays IP address and netmask (subnet mask) information for the CPUM card's Ethernet
interfaces.

o Info page that displays CPUM card firmware version and CompactFlash memory card part number
(PNR).

Note: The CPUM card Main page is the default page. It is displayed after the VM600 rack starts and is also
reverted to after one minute of inactivity on any other displayed page.

To access CPUM card information

The CPUM card Main page is the default page so it is automatically displayed after the VM600 rack starts. It is also
reverted to after one minute of inactivity on any other displayed page.

To access the CPUM card’s other pages, the OUT- and the OUT+ keypad controls (on the front panel of the
CPUM card) can be used to cycle through the pages as follows:

Main page < IP page < Infopage ( <« backto Main page)

When the front-panel display on the VM600 CPUM card is displaying card information, the first (top) row of the
display is used to indicate the CPUM card page as follows:

e (0/CPUM for the Main page, where 0 indicates the VM600 rack slot (always 0) containing the card.
e 0/IP for the IP page, where 0 indicates the VM600 rack slot (always 0) containing the card.
e 0O/INFO for the Info page, where 0 indicates the VM600 rack slot (always 0) containing the card.
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On the CPUM card Main page (0/CPUM), the information is displayed as follows:

RUN TIME — CPUM card run time in days (d), hours and minutes (hh:mm), that is, the elapsed time since the card
was last restarted.

SYS TIME - VM600 rack system time in hours and minutes (hh:mm) with the date (dd-mm-yy)

rh or a — VM600 rack (CPUM) security status disabled (access to VM600 rack allowed) or
enabled (access to VM600 rack blocked).

Note: The VM600 CPUM card contains a battery so that its internal real-time clock, used as a time reference for the
VMG600 rack system time, is always kept up-to-date even if the power supply is interrupted or removed.

On the CPUM card IP page (0/IP), the information is displayed as follows:

ETH1 IP and MASK — IP address and netmask (subnet mask) information for the CPUM card's primary network
interface in dot-decimal notation.

ETH2 IP and MASK — IP address and netmask (subnet mask) information for the CPUM card's secondary network
interface in dot-decimal notation.

Note: For CPUM cards that do not have a secondary network interface or whose secondary network interface is
disabled, ETH2 information is not displayed.

On the CPUM card Info page (0/INFO), the information is displayed as follows:
FW — CPUM card firmware version as SSS. For example, 082.

CF — CompactFlash memory card part number (PNR) as 209-595-300-SSS or 209-595-400-SSS, where XxXx-XXx-
4xx-xxx indicates a later version of the CPUM card (PNR 200-595-076-HHh or later) fitted with a PFM-5411 or
equivalent CPU module, xxx-xxx-3xx-xxX indicates an earlier version of the CPUM card (PNR 200-595-075-HHh or
earlier) fitted with a MSM586EN or equivalent CPU module, and SSS indicates the firmware version. For example,
209-595-400-082.

Note: On pages that contain information wider than the display itself, the information is automatically scrolled left to
right In order to make all of the information visible.

For the MPC4 and AMCS8 cards

The front-panel display on the VM600 CPUM card now displays improved VM600 MPC4 and AMC8 monitoring
card information as follows:

e MPC4 and AMCS cards:
o Main measurement page that displays the first available (configured) measurement on a channel and
output basis.
Note: The Main measurement page is the default page for any selected MPC4 or AMCS8 card.
o Subsequent measurement pages that display the next available (configured) measurements on a
channel and output basis.
o Info page that displays MPC4 or AMCS8 card information including card type (MPC4 or AMCS8), card
hardware version, card firmware version and elapsed time since the card was last configured.
e Note: The MPC4 or AMC8 card Main measurement page is the default page that is displayed after an MPC4 or
AMCS8 card is selected. After one minute of inactivity on any MPC4 or AMC8 card page, the VM600 CPUM
card will revert to its own Main page.
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To access MPC4 and AMCS8 card information

The MPC4 or AMCS8 card Main measurement page is the default page displayed when a VM600 rack slot
containing an MPC4 or AMCS8 card is selected, so it is necessary to first select an MPC4 or AMCS8 card in a VM600
rack slot in order to access/display this information.

To select an MPC4 or AMCS8 card in a VM600 rack slot, the SLOT=- and the SLOT+ keypad controls (on the front
panel of the CPUM card) can be used to cycle through the VM600 rack slots as follows:

Slot0 Slot 3 — Slot n — Slot 14 ( < DbacktoSlot0)
CPUx < MPC4or AMC8 <« MPC4or AMC8 < MPC4 or AMC8

Once an MPC4 or AMCS8 card has been selected, the OUT- and the OUT+ keypad controls (on the front panel of
the CPUM card) can be used to access/cycle through the card’s other pages as follows:

Main page <« Subsequent pagen <« Info page

The display of a Main measurement page and Subsequent measurement pages depends on an MPC4 or AMCS8
card being present in a VM600 rack slot and the configuration of the card. More specifically, the actual number of
Subsequent measurement pages that are displayed for a card depends on the number of measurements (channels
and outputs) that are configured.

When the front-panel display on the VM600 CPUM card is displaying MPC4 and AMCS8 card pages, the first (top)
row of the display is used to indicate the page as follows:

¢ n/m.o for the Main and Subsequent measurement pages, where n indicates the VM600 rack slot (in the
range 3 to 14) containing the card, m indicates the measurement channel and o indicates the
measurement channel output.

¢ n/INFO for the Info page, where n indicates the VM600 rack slot (in the range 3 to 14) containing the card.

On the MPC4 or AMCS8 card Main and Subsequent measurement pages (n/m.o), the information is displayed as
follows:

Bargraph — Current value for the selected measurement (channel and output indicted by n/m.o in the first (top) row
of the display). The alarm levels (— Danger and - - - Alert) for the measurement are also shown to the right of the
bargraph.

4-digit display — Current value for the measurement (channel and output indicted by n/m.o in the first (top) row of
the display).

UNIT — Unit for the measurement.

RECT — Rectifier (qualifier) for the measurement.

On the MPC4 or AMCS8 card Info page (n/INFO), the information is displayed as follows:
MPC4 or AMCS8 — Type of card.

HW — Card hardware version as HHH.

FW — Card firmware version as SSS.

CONF TIME - Elapsed time since the card was last configured in days (d), hours and minutes (hh:mm).
However, if there is a configuration error for the card, then CONF ERROR s displayed instead of CONF TIME.
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2.16.3 Increased VM600 rack (CPUM card) security

The VM600 rack security implemented by the CPUM card has been improved to be even more secure in order to
help combat growing cyber security risks.

VM600 MPS rack (CPUM) security consists of two levels of protection integrated in the CPUM card: CPUM access
lock and MPS password validation:

e CPUM Access Lock is a CPUM access setting that can be thought of as a “hardware” security feature that
limits Ethernet-based connections to a VM600 MPS to “read only” operations.

e MPS Password Validation can be thought of as a “software” security feature that limits Ethernet-based
connections to a VM600 MPS to “read only” operations plus a permitted subset of “write” operations.

When CPUM Access Lock is used to block access to the CPUM card (and therefore the rack), the CPUM card now
closes all unused ports in order to reduce the possibility of interference in the operation of the rack.

(Previously, when CPUM Access Lock was used to block access to the CPUM card: ports 21 and 23 were open
even though access via FTP and Telnet were not available, port 16001 was open even though access to the
fieldbus configuration was not available, and port 16002 was open (associated with XMC16 cards).)

This improved VM600 MPS rack (CPUM) security makes it easier to comply with the relevant regulations and
standards such as European Union Directive (EU) 2016/1148 on the security of network and information systems
(commonly referred to as the NIS directive), ISA/IEC 62443 standards on industrial communication networks —
network and system security, the North American Electric Reliability Corporation (NERC) critical infrastructure
protection (CIP) standards and the United States Nuclear Regulatory Commission (US NRC) cyber security
regulations.

2.16.4 Display of bargraphs by VM4600 CPUM card'’s front-panel display

The display of bargraphs by the front-panel display on the VM600 CPUM card has been improved to include
negative values.

When the bargraph now displays a measurement that has been configured with negative alarm values (Danger-
and/or Alert-), the bargraph will include the negative part of the measurement range.

(Previously, the bargraph only included the negative part of the measurement range if the current value for the
measurement was negative.)
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2.16.5 Easier configuration of time and date for a VM600 CPUM card
The time and date used by a VM600 CPUM card for the VM600 rack system time is now easier to configure.
In general, a VM600 CPUM card can be operated with or without an NTP server as follows:

e With an NTP server as a time reference — the CPUM Configurator software is used to configure the CPUM card
to use an external NTP server. The CPUM card obtains the time and date from the NTP server and periodically
synchronises with the NTP server in order to minimize the effects of the CPUM card’s clock drifting over time.

e Without an NTP server as a time reference — the CPUM Configurator software can now be used to configure
the time and date to be used by the CPUM card.

(Previously, when a VM600 CPUM card was operated without an NTP server, the time and date to be used by the
CPUM card was typically configured in the factory.)

To configure the time and date to be used by the CPUM card using the CPUM Configurator software:

1. Inthe CPUM Configurator window, click Set time.
2. Inthe resultant Select date dialog box, configure the date and time. Then click OK.

The VM600 CPUM card’s internal real-time clock will immediately start using the new time and date as the time
reference for the VM600 rack system time.

Note: When VM600 system and measurement event logging is used, the time and date must be set for the VM600
CPUM card in order for the timestamps in the system events and measurement events log files to be correct.
See 2.16.1 VM600 system and measurement event logging.

2.16.6 Sensor Information Editor file update

The underlying sensor list files (“sens_vm.txt” and “sens_vm_factory.txt”) used by the Sensor Information Editor of
the VM600 MPSx software were updated to include the CE620 general-purpose vibration sensors.

This allows MPC4 measurement channels to be automatically configured for a CE620 sensor.
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3 Solved problems / bug fixes

3.1 VMé00 MPSx software release 2.0 build 008

3.1.1 OC Bus relays were not correctly mapping

The user could correctly map the OCBus relays 1 through 4 but the NE/NDE settings for these relays were not
being saved correctly. This problem has been fixed.

3.1.2 Prevents DB Manager from renaming or deleting current database

The MPS Configuration code has been modified to allow the DB Manager to now rename or delete the currently
opened database. Previously, a file was being held open by the MPS software and this was preventing the
DBManager from perform the rename or delete operation

3.2 VMé600 MPSx software release 2.0 build 009

3.2.1 Fix database data deletion problem.

Fixed a problem when attempting to delete data from the database. If the user specified the time field as opposed
to deleting all data the user specified time was being used incorrectly. Daylight savings time wasn’t being
accounted for properly potentially causing the user entered date to be off by an hour.

3.2.2 Page selection problem

When the user selects a tabbed page in the window for Machines and Stations the MPS retains the last page
selected. Selecting another Station or Machine should cause the same tabbed page to be selected. For example,
selecting the Timing Info page for Machine 1 and then selecting Machine 2 in the tree-list should cause the Timing
Info page for Machine 2 to be displayed. This logic was not always working properly but this has been corrected.

3.2.3 Impossible to create a new database if it is the first one.

Prior to this release it was impossible to create a new database if it was the very first one. The user now has a
menu item that allows him to create a new database.

3.2.4 Incorrect initialization of AMC8 remote channel source field

When an AMCS8 board was added to a rack’s configuration the AMC8’s card level remote channel source slot
number was being initialized incorrectly to zero. This slot number information was in error and must be a value
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between 3 and 14. This error would be automatically corrected when the Card Level tree item was selected. A
“Save Changes?” message would appear the first time the user selected a new AMC8'’s card level tree item and
then selected a different tree item not on the current slot.

3.2.5 Changing databases problem fixed with Event Log

Fixed a problem that occurs when the user is currently recording data for an initial database and then selects a
different database for viewing. Any events intended for the initial database were being sent to the second
database’s event log.

3.2.6 Datarecording problem with powered off Racks fixed

Fixed a problem which occurred when the user started data recording while the rack was powered off. Powering
up the rack did not cause data recording to begin. In this instance data recording was required to be stopped and
then restarted before communications would be established.

3.2.7 Renaming or deletion of the currently opened database.

The code has been modified to allow the DB Manager to now rename or delete the currently opened database.
Previously, a file was being held open by the MPS software and this was preventing the DBManager from perform
the rename or delete operation.

3.3 VMé00 MPSx software release 2.0 build 010

3.3.1 Correctly implemented privilege change operations

The privilege change operations was not correctly handle, from Super to non-Super and back to Super level. The
screen objects generally remains enabled when they shouldn't be.

3.3.2 Privilege Change Updates

Additional items falling under the privilege change item. In particular, if the user was at Super level, made changes
either to the Database or Rack Window, dropped privilege level to Read, and then selected another tree item they
would be presented with the “Save Changes?” dialog - even though they were non-privileged.

3.4 VM600 MPSx software release 2.1 build 001

3.4.1 Window size/position logic problem fixed

A minor problem with the window size and position logic when the window is closed was fixed. If the user had the
window minimized when they closed MPS the screen sizes may have been incorrectly saved.
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3.4.2 MPCI1 Implementation caused some MPC4 display errors

There were some minor problems with the MPC4 displays which were introduced when the MPC1 board
implementation was made. In particular, for old configurations, the MPC4 Basic Logical Alarm and the MPC4 Input
channel displays where incorrect. These problems were resolved.

3.4.3 Display Plot Button was not operational for AMC8 channels

The “Display Plot” found on the non-linear compensation window for AMCS8 channels was, in certain instances,
becoming enabled. Unfortunately, there was no logic behind this button. It was there for future work. This button is
now ALWAYS invisible so that the user is never presented this option.

3.4.4 Problem with Basic Logical Functions with MPC

A problem was uncovered in the implementation of the MPCL1 logical functions for discrete outputs. In "discrete
outputs, relay mapping", anytime one attempted to map a relay with a "basic function”, the MPS would display:
"Measurement channel 3", regardless of which basic function was selected and if the basic function was actually
configured. This problem was corrected.

3.4.5 Re-implement card-level drag & drop

The ability to drag & drop at the card level and at the AMCS8 point level had been unintentionally removed in an
earlier release on the MPS software. This capability has been added back in.

3.4.6 Problem when accessing old database with AMCS8 cards

The AMCS8 boards were not being displayed properly if the database had been last written using earlier versions of
the MPS. This has been corrected.

3.4.7 MPS Sample Database has been updated

Several problems in the sample database released with the MPS distribution were made. These problems dealt
which inconsistencies in the data files for the various machines. A consistency check has been added which
checks to improve the database backward compatibility.

3.4.8 RS Processed Output 2 sometimes was not properly displayed

When the user changed processing from PS to RS the “Processed Output 2” tag wasn’t properly being changed to
display the text string “Gap”. This has been corrected.
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3.4.9 Speed channels incorrectly allowed Tacho Ratio editing

The Speed Channels incorrectly allowed the editing of the Tacho Ratio field for privileged users. This field is
correctly no longer editable for all users.

3.4.10 Narrow Band Tracking Problem

On the MPC 4 card of the VM 600, in the window “narrow band (tracking) vibration function configuration register”
the value of the “tracking speed upper / lower limit” is not the same when we configure it as when we read the
configuration from the card. After investigation, we found that the value of the “tracking speed” become wrong
when it exceed the half of the real full scale value. This bug appears when we read the configuration of the card.
This bug is independent of the “harmonic to process” value we set up. It happens either with frequency or with
RPM measurement. This problem was corrected and was due to the function processing the configuration read
back interpreting the NB function registers as signed values. This problem, while not reported, also existed for the
NBFS processing function.

3.4.11 Dynamic alarm level setting

The MPS software no longer recalculates alarm level settings based on changes being made the current full scale
value.

3.4.12 Ping problem related to “Power Users” identified

“Power Users” under Windows® XP have most privileges that the Administrator has. One notable exception is that
“Power Users” can’t perform raw socket I1/0. The MPS uses raw socket I/O to perform “pings” to the attached
racks. Without being able to ping the responsiveness in detecting a down rack is greatly impaired. Microsoft, in
their infinite wisdom allows the follow Registry change to re-enable raw socket I/O for “Power Users”:

[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters]

"AllowUserRawAccess"=dword:00000001

3.5 VMé600 MPSx software release 2.2 build 000

3.5.1 Fixed crashing problem when recording stopped

When data recording was stopped, under certain conditions the MPS would crash. This mainly had to do with
shutting down in an orderly manner the data acquisition threads. Also, if the user had switched between numerous
databases while collection was occurring then the stopping of recording could have caused an event log
synchronization problem.
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3.5.2 Jumper matrix shows wrong jumper to set

A problem concerning the jumper matrix for IOC4 boards incorrectly displayed, under certain conditions, has been
corrected. The problem occurred because during certain conditions the line attributions weren’t being properly
updated when the user changed the configuration. This problem, while not reported, also existed for IOC8 displays.

3.5.3 MPS with no databases problem

Under certain conditions one was able to have the database tree items but the “Logical” and “Architectural” buttons
were disabled. In other instances there could be no databases in the tree but the “Logical” and “Architectural”
buttons were enabled. These problem were corrected.

3.5.4 Rack level inconsistency when sending a configuration

Master Level users may now send the complete rack configurations configuration in one shot.

3.5.5 Machine data collection -> Max Data

Under certain conditions, a machine’s max data points value, entered by the user could cause some overflow
problems in the displays. This has been fixed. Additionally, this field has now been moved to the timing page.

3.6 VMé600 MPSx software release 2.2 build 005

3.6.1 MPS SW forgets user-defined passwords

Sufficiently privileged users can change the MPS passwords for the various privilege levels. The problem was that
the MPS was retaining these changed passwords for the current session but for subsequent sessions the MPS
reverted to using the default passwords. This problem has been fixed.

3.6.2 No IOC and RLC-16 jumpers Matrix diagrams when no printer is installed

The 10C-4 and RLC-16 jumpers matrix windows wouldn’t display if the system the MPS was being executed on
didn’t have any defined printers. The problem occurred because the MPS logic was attempting to use the default
printer’s sizes to scale the displays, in a WYSIWYG fashion. Unfortunately, if there weren’t any printers, the
displays are scaled into oblivion. The logic now scales the windows to an 8.5 by 11.0 inch page if no printers are
available. This works for both the letter-size and A4-size users.
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3.7 VMé600 MPSx software release 2.3 build 000

3.7.1 Default rectifier time for true-peak and true-peak-to-peak

The default rectifier times for the true-peak and true-peak-to-peak rectifiers were change from 0.0 seconds to 4.7
seconds.

3.7.2 MPC1 Service filter containing wrong LP filters parameter

For the GT-13E2 the LP filter parameter (10 kHz) related to the processing Dynamic Pulsation “service band”, was
corrected to 1000 Hz. A consistency check allows the user to fix old configurations which contain the incorrect
value.

3.7.3 Several serial I/O problems were addressed

Some minor RS-232 bugs when swapping a single RS-232 cable between multiple boards were uncovered and
addressed. These changes improve the reliability of communications. Also the application used to crash when at
the rack level, the “None” option was selected from the choices for Serial I/O and when in the selection-process the
same serial I/O channel was re-selected instead of another channel.

The ability to see the serial port mappings is based on whether any COM port mappings are present. If such
mappings exist, the user can see them. Only in the case where the CPU present is ticked and there are no serial
ports mappings will the ability to change/view serial port mappings be disabled at the board level. At the rack level,
serial port mappings will always be allowed.

3.7.4 AMCS linear compensation coefficient page editable after privilege change

Changing privilege level from Read level to Super level, while positioned in the “non-linear compensation” page of
the AMC windows, was allowing all of the filter coefficients to be editable, even for pre-defined sensor types. This
error was corrected.

3.7.5 Analog resolution point problem - value retained at deletion

When deleting a machine with an attached point having an associated analogue resolution value, this value is
retained in the “rack file”. Subsequently, adding this point to a different machine caused the point to have its
analogue resolution value restored from the retained value and not set to the default value.

3.7.6 NB Tracking Limits displaying as negative values

A display problem occurred when a configuration was read from the MPC4 board, using a version of MPS which
pre-dated MPS 2.0.027. This problem has been fixed.

3.7.7 Jumper setting — missing RAW_H on “IOC Jumper Matrix”

Another old problem (dating back to MPS 2.0.007) solved was the view of the "IOC Jumper Matrix" being incorrect
for some configurations (a problem with the "blank” Raw Signals/Raw Bus attribution).
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Also a display issue, happening when there are no more rawbus lines available to be mapped, was resolved. The
only option at that point is to remove an attribution, so the display logic was changed to perform this way.

3.7.8 Processing configuration parameters change when enabling “super” level

When changing privilege levels while positioned in a processing window, the processing parameters were reverting
to the default parameters. This old bug has now been corrected.

3.7.9 MPCI1 Speed Functions “un-set” automatically

Under certain conditions, the “MPC1/Alarm Configuration/Basic Function x/Speed Channel” would lose the fact that
it had been selected. This problem has been fixed.

3.7.10 Update MPC output-window with configuration changes

Every time the opened window detects a change from MPC not running to MPC running the configuration of that
card will be re-read. In earlier MPS versions changes in the configuration (as for example of the FSD) were not
seen and thus values might have been displayed wrongly.

To restrict traffic to the necessary, the configuration is not verified permanently or on a clocked schedule but
triggered by the change from MPC not running back to MPC running, which occurs after the changed configuration
has been sent and put to work on the card displayed in this window.

3.8 VM4600 MPSx software release 2.5 build 000

3.8.1 Configuration check for Absolute Shaft Vibration (AS) processing

Absolute Shaft Vibration (AS) processing is a dual-channel processing function and requires that one single-
channel input is configured for Broad Band Absolute Bearing Vibration (BBAB) processing and one single-channel
input is configured for Relative Shaft Vibration (RS) processing.

Absolute Shaft Vibration (AS) processing also requires that the constituent single processing channels (BBAB and
RS) use the same cut-off frequencies for their low-pass filters.

When Absolute Shaft Vibration (AS) processing is configured for the dual-processing channels of an MPC4 card
(that is, for operation with Channel 1 & 2 or Channel 3 & 4), the VM600 MPS software will check to ensure that the
associated single-channels are correctly configured and will display an appropriate message to the user if they are
not.

3.8.2 Broad Band Absolute Bearing Vibration (BBAB) rectifiers

Previously, N/A was incorrectly listed as an available rectifier function for Broad Band Absolute Bearing Vibration
(BBAB) processing so this N/A option has now been removed.
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3.8.3 Bar Chart plot improvements

The Bar Chart available in the VM600 MPS software for the display of live data has been improved as follows.
In the Bar Chart plot window:

The measurement (processed output) displayed is limited to two significant figures after the decimal mark.
The alarm limits displayed are limited to two significant figures after the decimal mark.

A zero reference indicator (0) has been added for the dynamic measurement channels and is displayed on the right
of the Bar Chart plot window (like the D+, A+, A— and D- alarm limit labels).
Note: The zero reference indicator is calculated from the values entered for the alarm limits.

3.8.4 Translation-related improvements

The quality of the translation of some French and German language text strings in the user interface were
improved as a result of user feedback.

On the Function tab of a dual-channel processing node in an Architectural View configuration tree:
“Keine Konfiguration nétig” has replaced “Kein” as the German translation of “No configuration required”.

In general, the use of Yes and No in English for buttons in dialog boxes when French or German has been selected
as the language of the VM600 MPS software user interface is normal system behaviour when English has been
selected as the language of the operating system (Windows® 7 and XP) for the computer running the VM600 MPS
software.

On the Timing Info tab of a Machine level node in a Logical View configuration tree:
“Nombre maximum de points” is used as the French translation of “Max Data Points”.
“Max Datenpunkte” is used as the German translation of “Max Data Points”.

In the Bar Chart plot options window:
“Grenzwert Labels anzeigen”, used as the German translation of “Show Limit Labels”, is now displayed in a wider
text box so that the full text string can be seen. (Previously, only “Grenzwert Labels anz” was displayed.)

In the Strip Chart plot data summary window:
“Résumé des données” is used as the French translation of “Data Summary”.
“Daten Zusammenfassung” is used as the German translation of “Data Summary”.

On the Timing Info tab of a Machine level node in a Logical View configuration tree, the “Approximate Maximum
File Size” text string now uses the file size units (MB, GB and TB) correctly in all languages. (Previously, the units
were displayed twice in English and French, and in both English and French for the French language translation.)

In certain locations of the German version of the user interface, the English “No” was incorrectly translated as
“Neine” and has now been changed to “Nein”.
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3.8.5 Inconsistency between the summary sheet and the dumped configuration for
an MPC4 card

For an MPC4 card, the summary sheet file (*.txt) and the configuration dumped to file (*.csv) were inconsistent in
their treatment of the Proximity Probe Initial Gap parameter.

For example, these files showed -5 mm, rather than the -6 mm configured in the VM600 MPS software.

This behaviour was due to an incorrect truncation that has been corrected.

3.8.6 MPS2 software can stop responding when recording data

Under certain circumstances, the MPS2 software can stop responding (“crash”) when recording (acquiring and
storing) data, particularly when the user switches from the Logical View to the Architectural View.

For example, the MPS2 software stops responding and a “this program needs to close” message is displayed.

In order to correct this, the behaviour of the MPS2 software has been modified so that the Architectural View is
disabled during recording and re-enabled when recording is stopped.

(In fact, the user level “super” falls back to “user” during recording so it was not possible to change the Architectural
view configuration anyway).

3.8.7 Rack names with non-alphanumeric characters

When a new rack was created in a configuration and the name (Tag) contained non-alphanumeric characters, the
VM600 MPS software did not handle this gracefully.

For example:

e Arack Tag containing a (forward) slash "/" resulted in the VM600 MPS software displaying an error message
and stopping responding.

e Arack Tag containing a colon ":" was apparently accepted but resulted in the VM600 MPS software not
saving the rack. That is, when the configuration was re-opened, the rack was not there.

In order to correct this, the behaviour of the MPS2 software has been modified so that it consistently accepts all
alphanumeric characters and symbols in a rack name (Tag) except for the following symbols: > </\|? *and “.

If an unaccepted symbol is used in a rack’s Tag, the rack is not saved and a message is displayed to inform the
user.

3.8.8 The summary sheet does not contain all of the MPCC information for an MPC4 card

The summary sheet file (*.txt) did not contain all of the information entered for an MPC4 card (by selecting the card
and using the File > MPCC - General Information menu command).

This has now been corrected and all of the MPCC information is now included at the start of the summary sheet
file.
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Note: MPCC refers to the MPCC software, a precursor to the VM600 MPS software that was designed for the
configuration of MPC4 cards in stand-alone racks (where each card was configured individually via the RS-232
connector on its front panel).

3.8.9 Exira numbers appearing in the German version of the dumped configuration for
an MPC4 card

When using the VM600 MPS software with the German user interface, the configuration dumped to file (*.csv) for
an MPC4 card contained extra numbers in the “VERARBEITUNG - VERARBEITETE AUSGANGE* section.

For example, as shown in red below:
VERARBEITUNG - VERARBEITETE AUSGANGE
Kanal,Kanal 1/Ausgang 1,Kanal 2/Augang 49202162,Kanal 3/Ausgang 1,Kanal 4/Ausgang 49202196

Ausgang belegt,Ja,Ja,Ja,Ja

Interne Verarbeitungsgrenze,30,30,30,15
Kanal,Kanal 1/Ausgang 2,Kanal 2/Augang 49202179,Kanal 3/Ausgang 2,Kanal 4/Ausgang 49202213
Ausgang belegt,Neine,Neine,Neine,Neine

This behaviour was due to an incorrect handling of the text string used to generate the dumped configuration which
has now been corrected.

In addition, the incorrect translation “Augang” has now been changed to “Ausgang”.

3.9 VM600 MPSx software release 2.6 build 000

3.9.1 Smax processing mode check for Absolute Shaft Vibration (AS) processing

Smax IS @ dual-channel processing function which requires that the engineering unit and rectifier function of the S«
output are the same as the engineering units and rectifier functions of the relative shaft vibration processing
functions (single-channels) that are used as its inputs.

However, when working at the Super privilege level with full access rights, it was possible for the S, processing
function’s engineering units and rectifier functions to be changed to be different from those used by the input
processing functions (relative shaft vibration). Further, it was possible to send such an incorrect configuration to a
VM600 rack.

In order to correct this, the behaviour of the MPSx software has been modified so that it now uses the engineering
units and rectifier functions used by the input processing functions (relative shaft vibration) by default. It also
performs a consistency check of Sy, processing functions in order to ensure that they are correctly configured and
any issues are displayed to the user using informative message boxes. In addition, it is no longer possible to send
a configuration with an incorrectly configured S;,.x processing function to a VM600 rack.
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3.9.2 Sending a configuration to a VMé00 rack
A configuration can be sent to a VM600 rack at one of two levels:

e Card level — by selecting a card (AMC8 or MPC4) in the configuration tree then using the
Communications > To AMC > Send Configuration or
Communications > To MPC > Send Configuration menu bar command as appropriate.

e Rack level — by selecting a rack in the configuration tree then using the
Communications > Send Configuration menu bar command.

When sending a configuration to a VM600 rack, the MPSx software prompts the user for confirmation with a
message box before continuing with the download. So when sending a configuration to a VM600 rack at the rack
level, the MPSx software prompted the user for confirmation for each card (AMC8 or MPC4) in the rack.

The behaviour of the MPSx software has been modified so that it now prompts the user for confirmation only once,
for both rack level and card level downloads.

3.9.3 Incorrect Alarm levels for Narrow Band (Vibration) processing function

Under certain circumstances, the Alarm levels configured for the Amplitude outputs of a Narrow Band (Vibration)
processing function were effectively ignored and lower levels were used so that the alarm outputs were effectively
saturated.

When an alarm is configured for the output of a processing function, the VM600 MPSx software calculates the
maximum value of the alarm and compares it to the full scale deflection (FSD) for the channel. If the calculated
maximum value of the alarm is less than the FSD value, then the calculated maximum value of the alarm is used as
the maximum value of the alarm, and if the calculated maximum value of the alarm is greater than the FSD value,
then the FSD is used as the maximum value of the alarm. However, depending on the configuration of a Narrow
Band (Vibration) processing function, the calculated maximum value of the alarm could be incorrect and the
incorrectly calculated maximum value of the alarm was used rather than the FSD, resulting in saturated Alarm
levels for the Amplitude outputs.

The incorrect calculation was due to an incorrect conversion factor (in RPM but should have been in Hz) that has
been corrected.

3.9.4 Sensor Information Editor causing the VMé00 MPSx software to stop responding

The Sensor Information Editor could cause the VM600 MPSx software to stop responding, depending on the
contents of the underlying sensor list file.

This behaviour was due to the underlying file parser used by the Sensor Information Editor, which has now been
improved to be more tolerant of incorrectly defined sensors in the text file (sens_info.txt) used in the background.
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3.9.5 Unable to send a configuration containing Absolute Shaft Vibration (AS) processing to a
VM600 rack

It was not possible to send a configuration containing Absolute Shaft Vibration (AS) processing to a VM600 rack if
the engineering units configured for the constituent single-processing channel outputs (BBAB and RS) and the
engineering unit configured for the dual-channel AS output required that integration was performed between an
input and the output.

This behaviour was due to improvements to the consistency check (in VM600 MPS version 2.5) which had
inadvertently removed the “permissions” that are necessary for the required integration to be performed.

3.10 VM600 MPSx software release 2.6 build 001

3.10.1 MPC Outputs window not displaying information from an MPC4 SIL card

When reading the outputs from an MPC4 SIL card, via the RS-232 connector on its front panel, the MPC Outputs
window does not display any information from the MPC4 SIL card and displays the error message “No possible to
import configuration from MPC4 SIL on standard MPC4 configuration”.

This behaviour of the VM600 MPS software has been improved so that MPC4 SIL cards are now handled correctly
by the MPC Outputs window.

See also 2.8.1 Improved support for the safety (SIL) version of the MPC4 card.

3.11 VM600 MPSx software release 2.7 build 010

3.11.1 Communication problems on the second Ethernet interface of a CPUM card

NOTE: Although originally documented in the VM600 MPS 2.7 build 010 release notes,
this bug fix was actually included in the VM600 MPS 2.7 build 012 software.

See 3.13.1 Communication problems on the second Ethernet interface of a
CPUM card.
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3.11.2 MPC4 SIL card support for functionality that is only valid for
non-safety-relevant signals

The VM600 MPSx software makes a distinction between the safety version o